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1.  JSR 309 Connector Requirements 

The following requirements are needed to be in place before installing the JSR 309 

Connector: 

 A functional TeleStax JBoss platform for development and testing. 

The JSR 309 Connector has been tested with the following JBoss versions of TeleStax 

Application Servers: 

 TeleStax Mobicents JBoss AS: 

mss-3.0.536-jboss-as-7.2.0.Final 

 TeleStax TelScale JBoss AS: 

TelScale-SIP-Servlets-7.0.2.GA-jboss-as-7.2.0.Final 

Note: Refer to www.telestax.com for any additional information about TeleStax 

Application Server and their licensing. 

 A functional PowerMedia XMS system. 

Note: Refer to Proper Configuration of PowerMedia XMS for additional information. 

 SIP phones or soft clients. 

http://www.telestax.com/
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2.  Contents of the Distribution 

This section lists and describes the files in the JSR 309 Connector distribution. 

Distributed Files 

The JSR 309 Connector distribution consists of a single TAR file: 

TeleStaxJBoss-msc#.#.tar 

This package contains the following structure: 

JSR 309 Connector Files Description 

DIR: 

/DlgcJSR309/application/ 

FILE(S): 

dlgmsc_tests.war 

deploymentDescriptor/ 

sample-src/ 

build.xml 

Directory that contains a deployable web 
archive that can be used to test the 

supported functionality. The WAR file 

implements several test servlets. Refer to 
Test Servlets for more information. 

It also contains the test servlets source 

files and build environment in order to 
simply create demo application project. 

DIR: 

/DlgcJSR309/lib/ 

FILE(S): 

dlgmsc.jar 

<third-party required jar files> 

Directory that contains the JSR 309 
Connector implementation for PowerMedia 

XMS and additional required third-party 
libraries. 

DIR: 

/DlgcJSR309/properties/ 

FILE(S): 

dlgc_JSR309.properties 

dlgc_demos.properties 

log4j2.xml 

Directory that contains the properties files 
used to set up configuration for JSR 309 

Connector and provided demos as well as 
xml configuration file for logging 

framework. 

DIR: 

/DlgcJSR309DemoPrompts/ 

FILE(S): 

prompts.tar 

JSR 309 Connector prompts used by demo 

application. Refer to Installing the Demo 

Prompts for further details. 
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3.  Installation and Configuration 

This section describes how to install and use the JSR 309 Connector. 

For system requirements and supported platforms, see JSR 309 Connector Requirements. 

Preparing the J2EE Converged Application Server 

The JSR 309 Connector has been deployed and tested on specific versions of TeleStax JBoss 
Application Servers. For quick instructions on how to install and configure desired AS for JSR 

309 Connector usage, refer to Appendix A: JSR 309 Connector Environment Setup. 

Installing the JSR 309 Connector 

The JSR 309 Connector is a library used by an application which needs to be configured 
within Application Server itself. 

The JSR 309 Connector demo applications provided with distribution is used to illustrate 

some functionality of the JSR 309 Connector. Refer to Test Servlets for further details. 

The following steps are necessary for JSR 309 Connector and demo application installation 
for correct operation: 

 Step 1 – Installation and Configuration of JSR 309 Connector 

 Step 2 – Installation and Configuration of JSR 309 Connector Demo 

 Step 3 – Proper Configuration of PowerMedia XMS 

 Step 4 – Verification of JSR 309 Connector using Demo Application 

You need to extract the distribution package as various components (files) will be needed to 
correctly complete each step. Refer to Contents of the Distribution which describes the 

contents in detail. 

Step 1 – Installation and Configuration of JSR 309 
Connector 

Simply place the package tar file on the TeleStax JBoss Linux server and run the following 

command: 

tar –xvf TeleStaxJBoss-msc#.#.tar 

This will create two directories, DlgcJSR309 and DlgcJSR309DemoPrompts, as described in 

Contents of the Distribution. 

Follow these steps to properly configure JSR 309 Connector: 

 Modify AS Startup Script – standalone.sh. 

 Configure JSR 309 Connector properties file. 

 Configure JSR 309 Connector logging facility. 

Modify AS Startup Script 

Edit the following examples and then add the section marked below in bold: 

(TelScale) /opt/TelScale-SIP-Servlets-7.0.2.GA-jboss-as-7.2.0.Final/bin/standalone.sh 

(Mobicents) /opt/mss-3.0.536-jboss-as-7.2.0.Final/bin/standalone.sh 
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Configure JSR 309 Connector Properties File 

The dlgc_JSR309.properties file is used to configure the location (IP addresses and ports) of 

the Application Server using JSR 309 Connector and the PowerMedia XMS Media Server to 
be used by connector. Follow the steps below to configuration the logging facility in 

Application Server platform: 

1. From the extracted distribution package, copy the dlgc_JSR309.properties file from 

the DlgcJSR309/properties directory to the Application Server directory: 

(TelScale) /opt/TelScale-SIP-Servlets-7.0.2.GA-jboss-as 

7.2.0.Final/standalone/configuration 

(Mobicents) /opt/mss-3.0.536-jboss-as 7.2.0.Final/standalone/configuration 

2. Edit the dlgc_JSR309.properties file according to your Application Server and 
PowerMedia XMS configuration. 

 The changes will include the AS IP address and port of the SipServlet 

container running the JSR 309 Connector. 

 Changes will also include the PowerMedia XMS IP address and port. 

 

 

 

 

 

 

 

Step 2 – Installation and Configuration of JSR 309 
Connector Demo 

At this point, an application can take advantage of JSR 309 Connector and use its resources 

for media related functionality. The JSR 309 Connector package provides a demo application 
which uses JSR 309 Connector to illustrate various media functionalities. This step will 

illustrate how to install and configure JSR 309 Connector demo application. Step 3 will 

illustrate how to verify that the demo application works with JSR 309 Connector and 
communicates correctly with PowerMedia XMS. 

Follow these simple steps to set JSR 309 Connector demo application: 

1. Modify AS Startup Script – standalone.sh. 

2. Configure JSR 309 Connector Demo properties file. 

3. Deploy JSR 309 Connector Demo application. 

 

… 

# Connector's address information (Typically same as the SipServlet container) your Application Server IP Address 
connector.sip.address=xxx.xxx.xxx.xxx 

connector.sip.port=5060 

…. 

#Media Server 
mediaserver.msType=XMS 
mediaserver.1.sip.address=xxx.xxx.xxx.xxx 
mediaserver.1.sip.port=5060 

…. 

“….. 
export JBOSS_HOME 
# Dialogic additions 
export APPSERVER_PLATFORM="TELESTAX" 
export DLG_PROPERTY_FILE=${JBOSS_HOME}/standalone/configuration/dlgc_JSR309.properties 
# Setup the JVM 

…..” 
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Modify AS Startup Script 

Edit the following examples: 

(TelScale) /opt/TelScale-SIP-Servlets-7.0.2.GA-jboss-as-7.2.0.Final/bin/standalone.sh 

(Mobicents) /opt/mss-3.0.536-jboss-as-7.2.0.Final/bin/standalone.sh 

Then, add the section marked in bold. 

 

 

 

 

 

Configure JSR 309 Connector Demo Properties File 

The demo properties file has various settings for various sample applications that can be 
modified. For detailed information on various configurations, refer to the descriptions of 

each sample application in Test Servlets. 

From the distribution package under DlgcJSR309/properties, copy the 

dlgc_demos.properties file to the following directory: 

(TelScale) /opt/TelScale-SIP-Servlets-7.0.2.GA-jboss-as-7.2.0.Final/standalone/configuration 

(Mobicents) /opt/mss-3.0.536-jboss-as-7.2.0.Final/standalone/configuration 

Deploying JSR 309 Connector Demo Application 

Next, JSR 309 Connector demo application needs to be deployed in the TeleStax Application 

Server. To do so, follow instructions in Deployment of Sample Application. 

Step 3 – Proper Configuration of PowerMedia XMS 

In order to verify the correct JSR 309 Connector installation with provided JSR 309 
Connector demos, you will need to correctly configure PowerMedia XMS Media Server. This 

includes: 

 PowerMedia XMS Web Admin Configuration. 

o Allowing Absolute Paths 

o Setting PowerMedia XMS to UDP_TCP 

 Demo required prompts installed on PowerMedia XMS itself (optional). 

Note: Only needed if JSR 309 Connector demo application is going to be used as it 

depends on these prompts to be installed on PowerMedia XMS. 

PowerMedia XMS Web Admin Configuration 

Allowing Absolute Paths 

JSR 309 Connector uses Native MSML interface to PowerMedia XMS Media Server. You need 

to verify that PowerMedia XMS is indeed configured for “Native” mode. 

Note: In PowerMedia XMS Release 2.1 and later, “Native” mode is the mode configured by 
default when PowerMedia XMS gets installed. Also, it is strongly recommended that the 

latest version of PowerMedia XMS be used. 

“….. 
export JBOSS_HOME 
# Dialogic additions 
export APPSERVER_PLATFORM="TELESTAX" 
export DIALOGIC_DEMO_PROPERTY_FILE=${JBOSS_HOME}/standalone/configuration/dlgc_demos.properties 
export DLG_PROPERTY_FILE=${JBOSS_HOME}/standalone/configuration/dlgc_JSR309.properties 
# Setup the JVM 

…..” 
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Now, under the Media menu, click on Media Configuration tab. The Allow Absolute 

Paths field must be set to YES. 

 

Once appropriate changes are made, click the Apply button which will commit the changes. 

Once changes are applied, you will be asked to restart PowerMedia XMS. This step is not yet 

required since we are going to be changing more configuration parameters below. 

Setting PowerMedia XMS to UDP_TCP 

Since TeleStax Application Server can switch between UDP and TCP depending on the size 
of the message it needs to send over SIP, the PowerMedia XMS need to be configured so 

that it can accept UDP as well as TCP packets. 

This setting can be found under Protocol menu and then under SIP tab where the 
Transport needs to be changed from UDP to UDP_TCP: 
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Once appropriate changes are made, click the Apply button which will commit the changes. 
At this point, it is time to restart PowerMedia XMS for all the configuration changes take an 

effect. 

Installing JSR 309 Connector Demo Prompts 

Custom prompts need to be installed on PowerMedia XMS as the various Dialogic demos will 
require them to work. Once installed, they should appear in the Media menu under the 

Media Management tab as shown below in the highlighted fields: 
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You can locate and install the demo prompts by performing the following: 

1. Copy the prompts.tar file inside the <Release Package>/DlgcJSR309DemoPrompts 
directory to the PowerMedia XMS system under the 

/var/lib/xms/media/en_US/verification directory. 

2. Untar file using the command; tar -xvf <file_name>.tar. 
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Step 4 – Verification of JSR 309 Connector using Demo 

Application 

With default dlgc_demos.properties file, you can use a simple DlgcPlayerDemo, which is 

part of supplied demo application WAR file. This demo simply answers an incoming call and 

uses JSR 309 Connector to request media resources from PowerMedia XMS in order to play 
an audio file. 

Before the deployed application can process SIP messages, it needs to be configured in SIP 

Servlets Management console: 

 Go to http://<as_ip_address>:8080/sip-servlets-management. 

 
 

 Click on INVITE tab and select Dialogic-Samples under SIP Application Name. 
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 Click Apply Changes button and a message on the bottom of your screen will 

confirm its success. 

- [INFO] DAR Information successfully updated 

 Now, your Application Server is configured to use newly deployed application. 

Follow these steps to run DlgcPlayerDemo for verification: 

1. Have a SIP client configured for supported audio codec. 

2. Place a call into Application Server with following URI: 

DlgcPlayerDemo@<as_ip_address> 

3. With successful configuration, you should hear a verification prompt being played 

out. 
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4.  Test Servlets 

This section describes the test servlets (basic sample applications) and requirements for 

running test servlets in the JSR 309 Connector. 

Test Servlets Overview 

Test Servlets, or sample applications, are included as part of distribution. They illustrate the 

use of the JSR 309 Connector. These test servlets are included in the dlgmsc_tests.war. For 

installation instructions and any additional requirements for running test servlets, refer to 
Installation and Configuration of JSR 309 Connector Demo and to Proper Configuration of 

PowerMedia XMS. 

Running the Test Servlets 

When using any standard SIP phone a special SIP URI will be used to initiate each test 

servlet. 

DlgcPlayerTest 

This test servlet plays a PowerMedia XMS pre-set prompt. 

Set up your SIP phone to point to the Web Application Server. Configure the SIP phone 

address (i.e., URI) to DlgcPlayerDemo. Make sure that the Web Application Server is 
running the dlgmsc_tests.war application. 

Using the demo property file, set the following: 

player.test.prompt= 

For example: 

player.test.prompt=file:////var/lib/xms/media/en_US/verification/greeting.wav 

The player will play this prompt. Make sure that the prompt file exists in the Media Server. 

To test the application, dial the following: 

DlgcPlayerDemo@<as_ip_address> 

DlgcDtmfPromptAndCollectTest 

This test servlet plays a prompt and collects DTMF digits. 

Set up your SIP phone to point to the Web Application Server. Configure the SIP phone 

address (i.e., URI) to DlgcPromptCollectDemo. Make sure that the Web Application 
Server is running the dlgmsc_tests.war application. 

The DlgcPromptCollectDemo can be controlled using the demo property file as follows: 

 The detectOnlyTest reads the number of signals property value and sends the 

pattern x (times number of signals). Note that no prompt is played. The following 
example generates a pattern to match of any five (5) DTMF entries: 

signalDetector.test=detectOnlyTest 

signalDetector.number_of_signals=5 

 The detectPromptCollectTest plays a prompt and looks for a given pattern. It does 

not make use of the number of signals property. 

signalDetector.test=detectPromptCollectTest 

signalDetector.match_pattern=min=1;max=5;rtk=# 
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 The detectCollectWithPatternTest does not prompt the user and only uses the 

match_pattern. 

signalDetector.test=detectCollectWithPatternTest 

signalDetector.match_pattern=min=1;max=5;rtk=# 

Note 1: You can configure the signal detector with the following properties (for 
example, the timeout values are based in milliseconds units): 

signalDetector.initial_digit_timeout=5000 

signalDetector.inter_digit_timeout=5000 

signalDetector.max_duration=10000 

Note 2: For the test that plays a prompt, you can control a loop (or how many times 
the test repeats the prompt and collect) by controlling the following property: 

signalDetector.loopCounter=2 

To test the application, dial the following: 

DlgcPromptCollectDemo@<as_ip_address> 

DlgcRecorderTest 

This test servlet records a greeting.  

Set up your SIP phone to point to the Web Application Server. Configure the SIP phone 

address (i.e., URI) to DlgcRecorderDemo. Make sure that the Web Application Server is 
running the dlgmsc_tests.war application. 

In the SIP phone, select your newly created test contact. You are prompted to record your 

greeting at the tone. After the tone, say your greeting, and enter #000 to play your 
greeting. 

After the greeting is played back, the application completes by hanging up the phone. If you 

do not enter #000, the greeting continues to record until the timeout is reached. 

The recording demo can be controlled in the demo property file by configuring the following 
record properties: 

record.test.file=file:////tmp/recorder_jsr309_test_demo.ulaw 

record.test.minDuration=6000 

record.test.maxDuration=60000 

record.test.initialTimeout=7000 

record.test.finalTimeout=4000 

record.test.silenceTerminationFlag=true 

To test the application, dial the following: 

DlgcRecorderDemo@<as_ip_address> 

DlgcDtmfAsyncTest 

This test servlet illustrates the asynchronous DTMF capabilities. 

Set up your SIP phone to point to the Web Application Server. Configure the SIP phone 

address (i.e., URI) to DlgcAsyncDtmfDemo. Make sure that the Web Application Server is 
running the dlgmsc_tests.war application. 

In the SIP phone, select your newly created test contact. Notice that there are no prompts. 

You will be connected. The application waits for you to press DTMF digits. For each DTMF 
pressed, the application will receive the DTMF and print the collected DTMF to the screen. 

Selecting the number 0 hangs up the connection. 

To test the application, dial the following: 

DlgcAsyncDtmfDemo@<as_ip_address> 
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Conference Demos 

The following table depicts the conference demos that are delivered with JSR 309 

Connector: 

Demo Name Functionality Requires 

JMCConferenceServlet Demonstrates 

how to create 
and manage 

multiple 
conferences. 

Media files need 

to be installed 
in the 

PowerMedia 
XMS for menu 

to work. 

DlgcAvLayoutConferenceDemo Implements an 

advanced 

conference. 

Media files need 

to be installed 

in the 
PowerMedia 

XMS for menu 
to work. The 

demo property 
file must be 

configured. 

DialogicBridgeConference Shows how to 

create a two leg 
conference 

without using a 
mixer. 

Media files need 

to be installed 
in the 

PowerMedia 
XMS for menu 

to work. 

JMCConferenceServlet 

This test servlet illustrates how to create and manage multiple conferences using a mixer 
control leg. A mixer control leg is an extra SIP connection used to control the conference 

mixer. 

Set up your SIP phone to point to the Web Application Server. Configure the SIP phone 
address (i.e., URI) to DlgcMultiConferenceDemo. Make sure that the Web Application 

Server is running the dlgmsc_tests.war application. 

In the SIP phone, select your newly created test conference contact. Notice that you will 
need at least two SIP phones. The first connection entering the conference will not hear 

anything until the other legs join in. 
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This conference performs the following: 

1. Establishes a network connection and joins it with a media group. 

2. Plays a prompt for a new number (conference pin) and collects signals. Any pin 
number can be provided. Initially no conferences exist. Conferences are created as 

users call in and provide pin numbers. Callers will only hear other callers who provide 
the same pin number. 

3. Creates a conference if a new pin is used, or adds a leg to an existing conference. 

To test the application, dial the following: 

DlgcMultiConferenceDemo@<as_ip_address> 

DlgcReferenceConferenceWithOutBCallServlet 

This test servlet illustrates how to implement an advanced conference that does not require 
a mixer control leg. The legs are connected directly into a conference without requiring any 

initial IVR functionality. 

Set up your SIP phone to point to the Web Application Server. Configure the SIP phone 
address (i.e., URI) to DlgcAvLayoutConferenceDemo. Make sure that the Web 

Application Server is running the dlgmsc_tests.war application. 

In the SIP phone, select your newly created test conference contact. Notice that you will 
need at least two SIP phones. The first connection entering the conference will not hear 

anything until the other legs join in. 

This simple conference performs the following: 

1. Can join multiple legs into a conference. 

2. Once in conference, the user can enter *00 to hear the conference menu and apply 
some of the menu options. 

The demo can be controlled by configuring the following properties in the demo property 

file: 

 Change the initial direction of legs by entering the following properties in the 
application demo property file: 

demos.join.direction.leg1=<duplex,recv,send> 

demos.join.direction.leg1=<duplex,recv,send> 

demos.join.direction.leg1=<duplex,recv,send> 

 To make an outbound call, make sure you have another accessible SIP phone that 

can receive calls and configure the following attributes: 

application.sipTOA_Address.sip.address=146.152.245.3 # IP address of the SIP Phone 

application.sipTOA_Port.sip.port=5060 

application.sipTOA.sip.username=kapanga  #(any name will do) 

application.early_media_bridge.sip.address=146.152.122.127 #AS Addr 

application.early_media_bridge.sip.port=5060 #AS SIP PORT 

 To run a video conference, make sure you set the following configuration: 

media.mixer.mode=AUDIO_VIDEO  # possible values AUDIO,AUDIO_VIDEO 

media.mixer.conf.video.size=VGA  # possible values VGA, 720p 

media.mixer.conf.recordfile=file:////tmp/confRecording  # recording the conference file 

full path. This also works for audio only conference. 

Note: To play the conference recording after the recording is completed, change the 
following attribute to point to the recording path: 

player.test.prompt=file:////tmp/confRecording then run DlgcPlayerDemo 

To test the application, dial the following: 

DlgcAvLayoutConferenceDemo@<as_ip_address> 
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DialogicBridgeConference 

This test servlet illustrates how to implement a simple conference that does not require a 

mixer, and that has two legs directly joined into it. 

Set up your SIP phone to point to the Web Application Server. Configure the SIP phone 
address (i.e., URI) to DlgcBridgeDemo. Make sure that the Web Application Server is 

running the dlgmsc_tests.war application. 

In the SIP phone, select your newly created test conference contact. Notice that you will 
need at least two SIP phones. The first connection entering the conference will not hear 

anything until the other legs join in. 

This simple conference performs the following: 

 Joins two calling legs into a simple conference. 

 In order for the leg to enter the bridge, each leg must enter *03 after making the 
call. 

To test the application, dial the following: 

DlgcBridgeDemo@<as_ip_address> 

DlgcEarlyMediaBridgeDemo 

This test servlet is similar to the DialogicBridgeConference defined above, except that it 
simulates an early media scenario. 

Set up your SIP phone to point to the Web Application Server. Configure the SIP phone 

address (i.e., URI) to DlgcEarlyMediaBridgeDemo. Make sure that the Web Application 
Server is running the dlgmsc_tests.war application. 
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The following sequence diagram illustrates DlgcEarlyMediaBridgeDemo: 
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Menu supported by DlgcEarlyMediaBridgeDemo: 

*00 – Plays announcement of menu options 

*77 – Plays announcement of how the demo works 

*88 – Plays announcement informing the user if the application is in a bridge or mixer 
conference 

*99 – Transfers the two call leg from a bridge conference to a full conference using a 

mixer 

Note: Once in a mixer conference, the test application does not allow you to go back 
to a bridge conference. The following property configuration must be set for this demo 

to work: 

application.sipTOA_Address.sip.address=146.152.245.3 # IP address of the SIP phone 

application.sipTOA_Port.sip.port=5060 

application.sipTOA.sip.username=kapanga  #(any name will do) 

application.early_media_bridge.sip.address=146.152.122.127 #AS Addr 

application.early_media_bridge.sip.port=5060 #AS SIP PORT 

To test the application, dial the following: 

DlgcEarlyMediaBridgeDemo@<as_ip_address>
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5.  Deployment of Sample Application 

Follow these steps to deploy a sample application: 

Start Mobicents Application Server: 

 From: 

/opt/mss-3.0.536-jboss-as-7.2.0.Final/bin/ 

 Run: 

./standalone.sh -c standalone-sip.xml 

Provided that the server has started without any errors/exceptions, the application is ready 

to be deployed: 

Go to: http://<as_ip_address>:8080. 

 

Click on Administration Console. Here, enter the appropriate login credentials. 



 

24 

 

Click on Manage Deployments. 

 

Click on Add button. 
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Click on Browse button and navigate to the dlgcmsc_demos.war file. Select it and click on 

Open button. 
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Click on Next. 
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Click on Save button. 

Now in the Manage Deployments view, you will see the newly deployed 
dlgcmsc_demo.war application. The next step is to enable it. 
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To Enable the deployed application, highlight it: 

 

Now, click on En/Disable button: 

 

Click on Confirm button. 

If deployment was competed successfully, you will see the deployed WAR file status as 

Enabled: 

 

The console window will indicate the same: 

 

The application WAR file can also be deployed by copying it to the application server itself 

under: 

$CATALINA_HOME/standalone/deployments 

The application server is monitoring the deployments directory and if new or updated WAR 

file is detected, it will attempt to start automatically. 
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6.  Troubleshooting 

This section provides basic troubleshooting techniques for the JSR 309 Connector. 

Logging 

The JSR 309 Connector and its sample applications use the Apache Log4j 2 logging facility. 
Unlike the previous version, the connector makes use of log4j2.xml file for its logging 

configuration. This log4j2.xml configuration file needs to be part of applications WAR file 

under “WEB-INF\classes\” directory. With the introduction of Log4j 2, it is possible to 
change the log levels without stopping/restarting any components. All the user needs to do 

is open log4j2.xml and change the logging to desired level. 

Note: In JBoss if the WAR file is deployed, it does not get unpacked so there is no way to 
get to log4j2.xml file in order to change the logging level. To overcome this, the application 

developer can create a directory called “<application-name>.war” instead of the 
<application-name>.war file and place all the contents of the WAR file in the directory. 

JBoss will treat this directory same as a WAR file but now access to log4j2.xml is possible. 

The JSR 309 Connector and sample applications log output file can be found in the 
“$CATALINA_HOME/logs/” directory - dlgmsc.log. The default logging level is set to debug. 

The application can also take an advantage of using Log4j 2 facility where it will have to 

make changes to the log4j2.xml file and accordingly add the appropriate appenders and 
loggers. Refer to the Apache Log4j 2 documentation at http://logging.apache.org/log4j/2.x 

for details. 

The application can also utilize platform logging facility where its configuration and 
modifications can be accomplished via appropriate Application Server Administration page. 

Refer to the application specific documentation for details. 

SIP Errors 

If the PowerMedia XMS returns “503 Service Unavailable”, make sure your network is 
correctly set up by performing the following actions: 

 Verify the available PowerMedia XMS licenses. 

 Check the /etc/hosts file configuration. 

 Make sure application properties file (i.e., dlgc_demos.properties) is referencing the 
appropriate PowerMedia XMS and Application Server IP address and ports. 

http://logging.apache.org/log4j/2.x
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7.  Building and Debugging Sample Demos in 

Eclipse IDE 

The JSR 309 Connector distribution comes with necessary configuration files and content 

needed to build Dialogic sample applications. This section is going to provide the steps on 
how to create, compile, build, and debug provided demo application using Eclipse IDE. 

Prerequisites 

User will need to have installed the following components: 

 Latest JDK version 1.7. 

Note 1: JDK 1.7.0_60 was used at the time of this publication. 

Note 2: The latest version of 1.7 JDK should be used as this is a version supported 
by TeleStax Application Server. 

 Eclipse KDE (Eclipse Standard SDK – Kepler Service Release 2 used here). 

 In order to build provided demo applications, you will need to obtain two TeleStax 

platform dependent libraries which are NOT provided as part of JSR 309 Connector 
distribution package. They can be found under the following directories: 

{JBOSS_HOME}/modules/system/layers/base/org/mobicents/javax/servlet/sip/main 

{JBOSS_HOME}/modules/system/layers/base/javax/servlet/api/main 

o (TelScale) 

 sip-servlets-spec-7.0.2.GA-TelScale.jar 

 jboss-servlet-api_3.0_spec-1.0.2.Final.jar 

o (Mobicents) 

 sip-servlets-spec-3.0.xxx.jar (xxx represents version of Mobicents 536 

for example) 

 jboss-servlet-api_3.0_spec-1.0.2.Final.jar 

Creating Build Environment 

Follow these steps to create a Dialogic demo build environment: 

1. From the distribution package, copy the DlgcJSR309 directory and its content to a 
known location on your system. 

2. Copy the required Application Server Platform specific libraries into the 

DlgcJSR309/lib directory. 

3. Open Eclipse IDE and go to File > New > Java Project. The following window will 

appear: 
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4. Uncheck Use default location and then click on Browse button. 
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5. Browse to the location of the copied DlgcJSR309 directory and select the application 

directory. Then, click OK. 

 

Note: Enter any Project name you wish to use in the Project name field. 

6. Now, click on Finish button. 
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Expanding the project in Eclipse should give you the following: 

 

Next, right click on name of your project in the Package Explorer view and select 
Properties. 

 

To configure for ANT builder, click on Builders. Now, deselect the existing Java Builder 

and click on New button. 
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Select Ant Builder and then click OK. 
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To name the builder, enter in a name in the Name section as shown below: 

 

Use the Main tab to define Buildfile and Base Directory: 

 Under Buildfile, click on Browse Workspace button and select the build.xml file in 
the application directory. Then, click OK: 

 

 Next, under Base Directory, click on Browse Workspace button and select the 
application directory. 
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 Then, click OK. 

The above changes will reflect the main configuration menu as shown below: 

 

Now, select the Targets tab: 
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Under Auto Build, click the Set Targets button. The demo target must be selected as 

illustrated below: 

 

Then, click OK. 
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You will now be returned to the Targets tab on the main configuration menu. Under During 

a “Clean”, click on Set Targets button. The only target that should be selected is the 
clean target.  

Note: The demo target will most likely be selected by default, in which case you will need 

to deselect it. 

 

Then, click OK. 
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Once returned to the Targets tab on the main configuration menu, click on Apply button: 

 

Next, to select the appropriate JRE environment which will be used for this project, click 

on JRE tab: 
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Under Runtime JRE, click on Separate JRE radio button. Then, click on Installed JREs 

button: 
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If under Installed JREs there is no option for jdk1.7.0_67 (version based on what was used 
in this installation example), click Add. Then, select Standard VM. 

 

Click Next.  
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Next, navigate to the location of your installed jdk1.7.0_67 file by clicking on the Directory 

button. 
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Select the appropriate JDK and click OK: 

 

Click on Finish button. 
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Now, make sure that the appropriate JDK is selected (in this case it would be jdk1.7.0_67). 
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Click OK. 
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Now, make sure that the Separate JRE has the appropriate version of JDK selected: 

 

Now, you have configured the appropriate JDK to be used by this project: 

 

Click Apply and then click OK. 
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To ensure that the newly created builder (ANT Builder) is at the top of the list, click on 

ANT Builder and position it by clicking on the Up button. 

Next, the Java Build Path needs to be configured. Click on Java Build Path and then click 

on Libraries tab: 



 

49 

 

Click on Add External JARs button. Locate and click on DlgcJSR309/lib directory. Select all 

the files in that directory and click Open. 

List of JAR files: 

 dlgcsmiltypes.jar 

 geronimo-commonj_1.1_spec-1.0.jar 

 jain-sip-sdp-1.2.91.jar 

 json_simple-1.1.jar 

 log4j-api-2.2.jar 

 log4j-core-2.2.jar 

 log4j-slf4j-impl-2.2.jar 

 mscontrol.jar 

 msmltypes.jar 

 org.osgi-3.0.0.jar 

 slf4j-api-1.7.5.jar 

 xbean.jar 

Also, you will need application server platform specific JAR files as referenced in the step 

below. 

Now, click OK. 
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The last step is to modify build.xml project file to use appropriate Application Server 

platform specific libraries (JSR files). To do that locate build.xml under newly configured 
project: 

 

Double click on build.xml file in order to open it for editing: 

 

Now, find the section as illustrated below and uncomment the appropriate platform section. 
In our example, TeleStax Mobicents JBoss is used: 
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Before: 

 

After: 

 
 

Now, click File > Save. The project configuration has now concluded. 

Building the Project 

After a successful project installation and configuration, a project can be built. In Eclipse, 

select the newly created project, then go under the Project menu and click on Build All. 

Successful build content will be shown in the Console view in Eclipse as follows: 

 

The newly built application WAR file will be located under DlgcJSR309\application\demo_app 
directory named demo_app.war. In order to deploy this application, follow the same 

deployment instructions as described in Installation and Configruation of JSR 309 Connector 

Demo.  



 

52 

Configuring Eclipse Project and TeleStax Application 

Server Deployed Application for Remote Debugging 

In order to connect the newly created project to the deployed WAR file in Application Server 

for debugging purposes, developers need to follow two simple steps: 

 Have Eclipse successfully build the JSR 309 Connector Demo Application WAR file 
and deploy it in the desired Application Server platform. Refer to Deployment of 

Sample Application. 

 Configure Application Server platform for remote debugging. 

Configuring Application Server Platform for Remote Debugging 

 Stop Application Server. 

 Edit and uncomment the line as illustrated below: 

(TelScale) /opt/TelScale-SIP-Servlets-7.0.2.GA-jboss-as-7.2.0.Final/bin/standalone.conf 

(Mobicents) /opt/mss-3.0.536-jboss-as-7.2.0.Final/bin/standalone.conf 

 

 

 
 

Note: The socket address specified above is 8787 by default but any port of choice 

can be used. Any port used needs to be enabled in a firewall in order to allow 
communication through it. 

 Start Application Server and make sure there are no errors in the console. 

Eclipse Project Configuration for Remote Debugging 

To configure the existing and working Dialogic JSR 309 project, the remote debugging 
section needs to be configured. In Eclipse, go to the Run menu and click on Debug 

Configurations: 

 

# Sample JPDA settings for remote socket debugging 

JAVA_OPTS="$JAVA_OPTS -
Xrunjdwp:transport=dt_socket,address=8787,server=y,suspend=n" 
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Double click on Remote Java Application: 

 

Specify the Name for this remote debugging configuration (for example, 

JSRAppRemoteDebugging). 

Under Connection Properties, specify the Host address, as well as the Port address of 
Application Server with deployed application for the debugger to connect to.  

Below is an example of what your window would look like once information is added: 
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Once done, click Apply and then click Debug. 

Note: Application Server needs to be running at this point. If not, Eclipse will report 
connection error message. If AS is running but Eclipse is still reporting a connection error, 

this could be due to either a port mismatch between Eclipse and AS firewall settings not 

allowing the specified port to be used; or there was simply a port conflict. 

 

Now, open debug perspective in Eclipse (Windows > Open Perspective > Debug). 

If nothing shows under the Debug section of a debug perspective, then a connection to AS 
has not been established. To connect/reconnect, go to the debug icon on the toolbar and 

choose the newly created remote debugging configuration: 

 

Once the remote debugging configuration is selected and a connection is established, 

the content of the Debug window should show running threads: 
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Now, the Eclipse project is connected to the build application that is deployed in TeleStax 

Application Server.
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8.  Appendix A: JSR 309 Connector Environment 

Setup 

This section describes, not going into platform details itself, a quick way to set up 

environment for JSR 309 Connector and JSR 309 application development. 

For system requirements and supported platforms, see JSR 309 Connector Requirements. 

This section does not go into details of Application Server platform, but simply will help build 
it quickly and be ready for use. 

It should be noted that OS level configuration should include the following: 

 Enable NTP (Network Time Protocol) 

 Enable ports in firewall (if applicable) 

Note: The following IP ports will have to be enabled in the firewall for the system to 
operate correctly: 8080 (TCP), 9990 (TCP), 5080 (UDP & TCP), and optional remote 

debugging port 8787 (TCP). 

If you need further details on TeleStax Application Server, visit: www.telestax.com. 

Installing and Configuring the TeleStax JBoss Application 
Server 

Note: If you are familiar with TeleStax AS or are planning to deploy on an existing TeleStax 

setup, proceed to Installing the JSR 309 Connector. 

Here are some highlights of the necessary steps: 

• Pre-Installation Setup 

• TeleStax Installation 

• TeleStax Configuration 

• Firewall Configuration 

• TeleStax Startup 

• TeleStax Verification 

Pre-Installation Setup 

Install OS supported by TeleStax – refer to www.telestax.com for details. For purpose of 

this documentation, CentOS 6.4/6.5 64-bit operating system with minimum installation 
options was used. Follow the steps below: 

 Log into newly installed operating system and install zip/unzip package: 

yum install zip unzip 

 Copy and install latest 1.7 version of JDK rpm package which can be downloaded 

from www.oracle.com. 

rpm –ivh jdk-7u60-linux-x64.rpm 

http://www.telestax.com/
http://www.telestax.com/
http://www.oracle.com/
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 Under /root directory edit .bashrc file and include the following export lines: 

(TelScale AS): 

export JAVA_HOME=/usr/java/jdk1.7.0_67/ 

export JBOSS_HOME=/opt/TelScale-SIP-Servlets-7.0.2.GA-jboss-as-7.2.0.Final/  

 (Mobicents AS): 

export JAVA_HOME=/usr/java/jdk1.7.0_67/ 

export JBOSS_HOME=/opt/mss-3.0.536-jboss-as-7.2.0.Final/ 

 Next, save the file and execute: source .bashrc for the changes to take an effect. 

 Edit /etc/hosts file and add a line at the very top of the file which corresponds to 
your systems IP address and the hostname example: 

xxx.xxx.xxx.xxx TelScaleJBossAS 

xxx.xxx.xxx.xxx MobicentsJBossAS 

 

Note: This must be the first line in the /etc/hosts file. If not, you might encounter 

a “503 Service Unavailable” error. 

Run the following command at the prompt: 

service network restart 

TeleStax Installation 

Copy the following to the system under the /opt directory and unzip them: 

(TelScale AS) - TelScale-SIP-Servlets-7.0.2.GA-jboss-as-7.2.0.Final.zip 

(Mobicents AS) - mss-3.0.536-jboss-as-7.2.0.Final.zip 

TeleStax Configuration 

Edit the TeleStax specific configuration file by completing the following: 

 Replacing any reference to “127.0.0.1” to your system’s hostname: 

/opt/TelScale-SIP-Servlets-7.0.2.GA-jboss-as-7.2.0.Final/ 

standalone/configuration/standalone-sip.xml 

/opt/mss-3.0.536-jboss-as-7.2.0.Final/standalone/configuration/standalone-sip.xml 

 Replacing any reference to “127.0.0.1” to your hostname as given during install. This 

step is required to allow other connections than localhost. 

Note: Needs to match what is in /etc/hosts file: 
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(TelScaleJBossAS used as an example) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Firewall Configuration 

At this point, we need to allow several ports to go through the firewall. Ports which are 

going to be in use are: 8080, 9990, 5080, and optional remote debugging port: 8787. To do 

this, simply edit /etc/sysconfig/iptables files and add the lines in bold, making sure they are 
added before the REJECT lines: 

vi /etc/sysconfig/iptables 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

# Firewall configuration written by system-config-firewall 

# Manual customization of this file is not recommended. 

*filter 

:INPUT ACCEPT [0:0] 

:FORWARD ACCEPT [0:0] 

:OUTPUT ACCEPT [0:0] 

-A INPUT -m state --state ESTABLISHED,RELATED -j ACCEPT 

-A INPUT -p icmp -j ACCEPT 

-A INPUT -i lo -j ACCEPT 

-A INPUT -m state --state NEW -m tcp -p tcp --dport 22 -j ACCEPT 

-A INPUT -m state --state NEW -m tcp -p tcp --dport 8080 -j ACCEPT 

-A INPUT -m state --state NEW -m tcp -p tcp --dport 9990 -j ACCEPT 

-A INPUT -m state --state NEW -m tcp -p tcp --dport 5080 -j ACCEPT 

-A INPUT -m state --state NEW -m udp -p udp --dport 5080 -j ACCEPT 

#optional port needs to be opened if remote debugging is required. 

-A INPUT -m state --state NEW -m tcp -p tcp --dport 8787 -j ACCEPT 

-A INPUT -j REJECT --reject-with icmp-host-prohibited 

-A FORWARD -j REJECT --reject-with icmp-host-prohibited 

COMMIT 

       <subsystem xmlns="urn:jboss:domain:webservices:1.2"> 
            <modify-wsdl-address>true</modify-wsdl-address> 

            <wsdl-host>${jboss.bind.address:TelScaleJBossAS}</wsdl-host> 

            <endpoint-config name="Standard-Endpoint-Config"/> 
            <endpoint-config name="Recording-Endpoint-Config"> 

                <pre-handler-chain name="recording-handlers" protocol-bindings="##SOAP11_HTTP 

##SOAP11_HTTP_MTOM ##SOAP12_HTTP ##SOAP12_HTTP_MTOM"> 
                    <handler name="RecordingHandler" 

class="org.jboss.ws.common.invocation.RecordingServerHandler"/> 
                </pre-handler-chain> 

            </endpoint-config> 
            <client-config name="Standard-Client-Config"/> 

        </subsystem> 
        <subsystem xmlns="urn:jboss:domain:weld:1.0"/> 

        <subsystem xmlns="urn:org.mobicents:sip-servlets-as7:1.0" application-
router="configuration/dars/mobicents-dar.properties" stack-properties="configuration/mss-sip-stack.properties" 

path-name="org.mobicents.ext" app-dispatcher-class="org.mobicents.servlet.sip.core.SipApplicationDispatcherImpl" 
concurrency-control-mode="SipApplicationSession" congestion-control-interval="-1"> 

            <connector name="sip-udp" protocol="SIP/2.0" scheme="sip" socket-binding="sip-udp"/> 
            <connector name="sip-tcp" protocol="SIP/2.0" scheme="sip" socket-binding="sip-tcp"/> 

            <connector name="sip-tls" protocol="SIP/2.0" scheme="sip" socket-binding="sip-tls"/> 

            <connector name="sip-ws" protocol="SIP/2.0" scheme="sip" socket-binding="sip-ws"/> 
        </subsystem> 

    </profile> 
 

    <interfaces> 
        <interface name="management"> 

            <inet-address value="${jboss.bind.address.management:TelScaleJBossAS}"/> 

        </interface> 
        <interface name="public"> 

            <inet-address value="${jboss.bind.address:TelScaleJBossAS}"/> 

        </interface> 
        <interface name="unsecure"> 

            <inet-address value="${jboss.bind.address.unsecure:TelScaleJBossAS}"/> 

        </interface> 

    </interfaces> 
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Save the file and restart the firewall for the changes to take effect by executing the 

following command: 

service iptables restart 

TeleStax Startup 

Now, you are ready to run Application Server. Go to: 

/opt/TelScale-SIP-Servlets-7.0.2.GA-jboss-as-7.2.0.Final/bin/ 

/opt/mss-3.0.536-jboss-as-7.2.0.Final/bin/ 

Then, execute the following command: 

./standalone.sh -c standalone-sip.xml 

 

 

 

To stop the service, press Ctrl-C. 

TeleStax Verification 

Once application server service are started the access to TeleStax Apache-Tomcat Web 

Administration can be done from any browser by going to the following URL: 

http://<as_ip_address>:8080 
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By default, you will not be able to access the Administration Console. You will see the 

following screen: 
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Because no user access has been set up yet, follow these steps to enable user access: 

 Go to the “/opt/mss-3.0.536-jboss-as-7.2.0.Final/bin/” directory and execute “./add-

user.sh” and follow the prompts: 

 

 Choose Management User by simply pressing Enter. 

 Press Enter to accept ManagementRealm. 
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 Type a username of your choice. 

Note: You will need these credentials to log into the Web Console later on (for 
example, admin). 

 Type in a password and confirm it (for example, testing1!). 

 Then, respond with “yes” to the next three questions and you are done. 

 Now, go back to http://<as_ip_address>:8080 and click on Administration 

Console link on that page. 

 Type in credentials for the user you just created. 

 

 You will now be able to log into the administration page by clicking on the Log In 
button. 

Note: You can always re-run add-user.sh script to change previously defined 

settings. 
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9.  Appendix B: Redundant Media Server 

Configuration 

The Redundant Media Server feature provided by the JSR 309 Connector supports hot 

active/standby redundancy. The JSR 309 Connector allows for “n” number of PowerMedia 
XMS systems to be configured where only one is an active Media Server and the rest are 

considered standby. This section explains how to configure hot active/standby. 

A primary (hot active) or a single (redundancy is not used) PowerMedia XMS is defined in 
the dlgc_JSR309.properties file: 

 

 

 

 

 

 

 

 

 

 

Redundancy configuration can be found under the “Dialogic PowerMedia XMS MS 

Redundancy Configuration” section in the dlgc_JSR309.properties file: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To turn Media Server redundancy feature on the following steps need to be taken: 

#################### Dialogic PowerMedia XMS MS Redundancy Configuration ###################### 

# mediaserver.redundancy - turns redundancy feature "on" or "off" 

# Default - off 

mediaserver.redundancy=off 

 

# Configuration of secondary set of PowerMedia XMS Media Server(s): 

# NOTE: Configuration of primary PowerMedia XMS Media Server is defined in 

# JSR 309 Connector Configuration section above as mediaserver.1. 

# 1) Replicate the two lines below for each PowerMedia XMS used as secondary Media Server 

# 2) change mediaserver.x to the next appropriate index 

# 3) configure appropriate IP and PORT for each 

# NOTE: number of Media Servers defined below has to match mediaserver.count parameter. 

mediaserver.x.sip.address=xxx.xxx.xxx.xxx 

mediaserver.x.sip.port=xxxx 

 

# mediaserver.redundancy.check.interval (in milliseconds) defines a time interval used by 

# by JSR 309 Connector for sending a keep alive ping 

# Default - 5000 

mediaserver.redundancy.check.interval=5000 

 

# mediaserver.redundancy.nonprimary.discover.clock.cycle defines a number of cycles to delay 

# keep alive ping for every secondary Media Server(s) 

# NOTE: cycle is used for secondary Media Servers and only used on initial discovery, 

# i.e., startup of JSR 309 Connector. 

# cycle * interval = seconds to wait before pinging secondary Media Server 

# Default - 1 

mediaserver.redundancy.nonprimary.discover.clock.cycle=1 

####### END - Dialogic PowerMedia XMS MS Redundancy Configuration ############################# 

#################### Dialogic PowerMedia XMS Media Server Configuration ####################### 

# Configuration of PowerMedia XMS Media Server 

mediaserver.1.sip.address=xxxx.xxxx.xxxx.xxxx 

mediaserver.1.sip.port=xxxx 

 

# mediaserver.count defines the number of PowerMedia XMS Media Servers used 

# by the JSR 309 Connector. 

# Supported values: 

# 1: Specifies single Media Server configuration (Redundancy not used) 

# <2-n>: Specifies ALL Media Servers to be used by connector (Redundancy ON). 

#  NOTE: Requires Redundancy Configuration section to be configured. 

# Default - 1:  

mediaserver.count=1 
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In the “Dialogic PowerMedia XMS Media Server Configuration” section: 

 mediaserver.1.sip.address and mediaserver.1.sip.port need to be configured for hot 
active Media Server. 

 mediaserver.count needs to specify a total number of Media Servers to be used by a 

connector (one designated as a active hot and others designated as active 
standbys). 

For example, if there are 4 Media Servers to be used where one of them is hot active 

and other 3 are considered hot standbys mediaserver.count needs to be set to 4 (1 
hot active and 3 hot standbys). 

In the “Dialogic PowerMedia XMS MS Redundancy Configuration” section: 

 mediaserver.redundancy needs to be set to “on”. 

 mediaserver.x.sip.address/port set of parameters need to be configured for hot 

standby Media Servers where x is from 2-4 (if total of 4 Media Servers are used). 

Optional: 

 mediaserver.redundancy.check.interval parameter defines a time interval in 

milliseconds for the JSR 309 Connector to send a keep alive ping to all configured 

Media Servers. 

Default - 5000 

 mediaserver.redundancy.nonprimary.discover.clock.cycle parameter defines a 
number of cycles to delay a keep alive ping for every hot standby Media Server. 

Note: The cycle is used for secondary Media Servers and only used on initial 

discovery (i.e., startup of the JSR 309 Connector). 

cycle * interval = seconds to wait before pinging hot standby Media Server 

# Default - 1 

For details on how the JSR 309 Connector Media Server Redundancy works, refer to the 

Redundant Media Servers Guidelines section in the Dialogic® PowerMedia™ JSR 309 
Connector Software Developer’s Guide. 
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10.  Appendix C: Updating the JSR 309 Connector 

The JSR 309 Connector comes as a set of JAVA library files (JAR). In the TeleStax 

Application Server, the required application files are part of the application WAR file 
structure. 

To update the WAR file with a new dlgmsc.jar file, the JSR 309 Connector library needs to 

be placed inside the application WAR file under the “lib” directory. 

To do so, open the <ApplicationName>.war file using an archiver utility (for example, a 
third-party program like 7-Zip) and replace with the new JSR 309 Connector JAR files under 

the “WEB_INF/lib” directory as shown below: 
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